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Interstate Access Overview

» Why is Interstate Access Management
important?

»Why is IAJR required?
»What is the IAJR Policy?



Interstate Highway _System

U.S. Interstate Highway System

» Backbone of the nations' surface
transportation system

» 60+ years

» Played major role in shaping
nation’s economy & development

» Led to increase in traffic demand

» Demand for access

> Interstate Highways in Texas ® 9P
> >3000 miles o zﬁw
» > dozen of primary and % @
auxiliary routes oY o

» 4 of 10 longest Interstates

Texas Interstate ‘ @
Highway System




The Interstate Highway Access Management

» Need for access
» New or modified
» Support development
» Access to other system

» Access management
» Location & Design
» Safety & Operation

» Challenges
» Points of conflict
» Balance between
access and mobility




Legal Authority for_the Interstate Access Policy

United States Code (USC) - Title 23
Section 111 - Agreements relating to use of and access
to rights-of-way - Interstate System

“All agreements between the Secretary and the State

transportation department for the construction of projects on

the Interstate System shall contain a clause providing that the

State will not add any points of access to, or exit from, the

project in addition to those approved by the Secretary in the

plans for such project, without the prior approval of the

Secretary.”

The USDOT Secretary has delegated this authority to the Federal Highway
Administrator




FHWA Policy on Access Changes to the Interstate System

“It is in the national interest to preserve and enhance the Interstate
System to meet the needs of the 21st Century by assuring that it
provides the highest level of service in terms of safety and mobility.
Full control of access along the Interstate mainline and ramps, along
with control of access on the crossroad at interchanges, is critical to

providing such service.



FHWA Policy on Access Changes to the Interstate System

Therefore, the Federal Highway Administration's (FHWA) decision to approve
new or revised access points to the Interstate System under Title 23, United
States Code (U.S.C.), Section 111, must be supported by substantiated
information justifying and documenting that decision. The FHWA's decision to
approve a request is dependent on the proposal satisfying and documenting
the following requirements:

1. Operational and Safety Analysis
» Maintain the safety and operational integrity of the Interstate System

2. Access and Design

» Connects to a public road and provides for all traffic movements
» Meet the current design standards



Introduction

Purpose

Legal
Background

Policy

Evolution

>
>

>
>

Provide TxDOT Guidance based on FHWA Access Guide ¢

Provide consistent point of reference for Districts, DES, and FHWA
(Tx Div)

Improve probability and ease of acceptance by FHWA
Clarify importance of Early coordination with DES and FHWA

¢

> Title 23, United States Code, Highway Section 111

> State will not add any point of access w/o0 approval of Secretary
USDOT

> Title 49, Code of Federal Regulation (CFR), Section 1.48

> Secretary delegated the authority to FHWA

FHWA Policy

> October 22, 1990
> February 1998

> August 2009

>
May 2017 *Pending Issuance of this SOP as current

> TxDOQOT Policy policy

» October 19, 2018 Memo*



TxDOT’s Policy for IAJRs

TXDOT’s Policy for IAJRs

> Incorporates the two updated points in the FHWA May
2017 Policy

> Effects of revised access on Safety and Operations

- S
| Procedure

——

»Access, Connection and Design
> Retains the six points in the FHWA August 2009 Policy
> Need
> Alternatives
> Consistency w/Local and Regional Plans
> Potential future multiple Interchange additions
> Coordination w/ Local Development/Transportation

» Environmental Review Status



Attachment A TxDOT’s Policy for IAJRs

Interstate Access Justification Repo
TxDOT Standard Operating Procedures (SOP)

Attachment A
Supporting Documentation for

TxDOT's Policy for Interstate Access Justification Reports (IAJRs)

On May 22, 2017, FHWA issued a new policy replacing the August 27, 2009 policy regarding “Access to
the Interstate System.” The previous 2009 FHWA policy has typically been referred to as an eight-point
policy, with the May 22, 2017 FHWA policy referred to as the two-point policy. It is important to note
the following from the two-point policy:

“This policy replaces the policy of August 27, 2009 on “Access to the Interstate System,”
published at 74 Federal Register 43743. The changes in this policy are made to ensure this
policy focuses on safety, op ional, and engi ing issues. The consideration of sodal,
economic, and environmental impacts discussed in the 2009 policy are removed from this
policy. However, the removal from this policy does not eliminate the need to consider those
matters. Those issues will be addressed under the National Environmental Policy Act (NEPA)
and other statutes and regulations applicable to the approval process.”

The May 22, 2017 FHWA policy is i ded to elimi the p ial for duplicative analysis of the
sodial, economic, and environmental impacts and planning considerations in both the Interstate Access
report and the NEPA D ion. The ption being that it was a duplicative process in every
state.

Following FHWA's release of the May 22, 2017 change in policy, TxDOT representatives met with FHWA
Texas Division staff to discuss TxDOT's current process and to determine an acceptable approach in
response to FHWA's change in policy. It was determined that TxDOT's process, is not duplicative and, if
TxDOT adopted the May 22, 2017 FHWA policy, without revising its NEPA Documentation procedures,
required elements of the overall process would no longer be adequately addressed. TxDOT does not
plan to revise its NEPA Documentation procedures.

As a result, the six points of the previous policy, addressing the consideration of social, economic, and
environmental impacts and planning considerations, remain as part of the components of TxDOT's |AIR

lysis and doc , in ition to the two points in the May 22, 2017 FHWA policy, for
a total of eight. The IAJR will also be included, by reference, as an attachment to the NEPA
documentation.

Please note, TxDOT is not proposing to follow the previous FHWA 2009 policy rather than FHWA's May
22, 2017 policy. As shown in Tables 1 and 2 below, the points in the May 22, 2017 policy addressing
safety, operational, and engineering acceptability are not the same as the two respective points in the
previous 2009 FHWA policy.



Requirements

Which Access Changes require IAJRs?
> Based on FHWA Access Guide
> Three types of delegation for access processing

> FHWA Headquarters Approval

> FHWA Division Office Approval

> FHWA Coordination
> Attachment B-1 lists access changes requiring FHWA review and action
> Attachment B-2 lists changes not requiring FHWA review and approval

> Documentation requirements dependent on the project context



Access Changes Requiring IAJRs

Interstate Access Justification Report
TxDOT Standard Operating Procedures (SOP)

Attachment B-1
Interstate Access Changes Requiring FHWA Review and Action

Federal Delegation of Authority for Access Approval*

Type of Access Change FHWA Headquarters | FHWA Division Office
New Freeway-to-Freeway Interchange X
IMajor Modification of Freeway-to-Freeway Interchange X
New Partial Interchange X
MNew Ramp(s) to/from Continuous Frtg Rd X
MNew Freeway-to-Crossroad Interchhange Within Traffic X
IManagement Area (TMA)
New Freeway-to-Crossroad Interchange Outside TMA X
IMajor Modification of Existing Freeway-to-Crossroad Interchange X
Adding New Ramp(s) to an Existing Interchange X
Removing Ramp(s) from an Existing Interchange X
Changing the Interchange Configuration X
Completion of Basic Movements at Partial Interchange X
Locked Gate Access X
Abandonment of Ramps or Interchanges X
*Based on FHWA Access Guide
Attachment B-2
Examples of Projects Not Requiring FHWA Review & Approval
| Type of Access Change |

« Adding Turn Lane or Through Lane on Cross Road at Ramp Termini

« Widening of Existing Ramp to Add Lane(s)

= Relocate Ramp Termini Along Cross Road

= Relocating Existing Entrance/ Exit Gore Point Along Freeway Mainline
* Adding an Auxiliary Lane Between Two Adjacent Interchange Ramps

+ Signal or Channelization Improvements of Ramp Terminal Intersection with Cross Road
= Modification in length of acceleration or deceleration lanes on ramps
« Implementation of ramp metering

+ new signing, sriping, and/or resurfacing on on-ramps or off-ramps

= Construction of overpassess or grade seperation structures

+ Changes in access between managed lanes and general purpose lanes

NOTE: Projects do not require FHWA review and action, but coordination with Design Division and FHWA may be
required based on context of project.
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IAJR Process

Key Stages

PROJECT INITIATION

Need and Purpose

Methodology
Traffic
Forecast CGOORDINATION
Crash Data Access &
; i Draft
Traffic Exist Cond : Design Submission
Analysis Benefits/
Impacts
TRANSPORTATION REVIEW &

COORDINATION
ANALYSIS Recommendations APPROVAL

Safety
Analysis



Project Development & IAJR Timeline

Preliminary
Engineering &
Schematics

Planning/Corridor
Studies

Final Design and Letting &
PS&E Construction

IAJR

< 1 Years 12 - 24 Months . <3Years

»
<« » ¥ » N »



IAJR Schedule |

Typical Average Schedule

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18

Methodology -

Data Collection
Traffic Forecasting

Traffic Analysis I

Safety Analysis

Draft Report -
TxDOT Review -
FHWA Review I

B Months to Complete



TxXDOT IAJR Process

TxDOT IAJR Coordination Process
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TV 80 FT- Early Coordination

TxDOT IAJR Coordination Process
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IAJR Phase:| Draft Submittal to DES

TxDOT IAJR Coordination Process
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TV 80 - Submittal to FHWA

TxDOT IAJR Coordination Process

s e a
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IAJR Phase: |

TxDOT IAJR Coerdination Process
== =
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IAJR Phase:

TxDOT IAJR Coordination Process
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TV 80 FT- Early Coordination

District ldentifies a
need for 1AJR and o o Develop and District conduct
District schedules an 1 *| Finalize M&A ———>| Analysis and prepare |———
internal TxDOT memo Schematics
kick-off meeting
A [
Attends : ;
i Provid
Attends ME&A i Supr;::lrt ?or
DES-PDSS kick—pﬁ —> coordi_nation | Schematic
meeting me.etlng to i development
discuss !
Provide Provide support
support M&A i on Engineering,
DES-TSSA i Operation and
Safety Analysis
$ 7
Crash Data
TRF requested i
5 A |
Project |
Reasonable i
FHWA i
Attends If No
M&A 1
coordination End
meeting to !
discuss !
Traffic Data |
TPP Requested
Consultant
PEPS Contract
Support

M&A Memo will be considered Final with concurrence of FHWA, DES, and District.




IAJR Phase:| Draft Submittal to DES

District

District submils draft IAJR & Schematic - Two Hard Copies Each I
1AJR and Schematic IAJR, Schematic, Native Analysis Files - Electronic Copy
DES.-PDSS B PDS3 L Review of schemalic and Conzolidate review
mf:ﬁ:f:g;’:‘;;“ engineering components comments and submit to
f 1AJR District and TSSA
TSSA and TRF ¢ SRS
Operation and Safety
DES-TSSA Analysis components of
1AJR and submit
comments to PDSS
Review of signing
TRF Schematic and submit
comments fo PD3S
FHWA
TPP

PEPS



TV 80 - Submittal to FHWA

@ Address review
" comments
Lo Re-submit Schematic
and IAJR
Iy
Submit to FHWA for | AJR - Two Hard Copies
@ = review/approval and Schematic - One Hard Copy
DES-PDSS copy to District and IAJR, Schematic, Native Analysis Files - Electronic Copy
TSSA
Provide support Verifylreview
comments
were
DES-TSSA addressed
&
If No
TRF
cceptability
of Eng. If Y
FHWA Operations e
and Safety
Analysis

TPP

PEPS



IAJR Phase: - ttal t |

District
DES-PDSS

DES-TSSA

If No

FHWA

PEPS



IAJR Phase:

District

DES-PDSS

DES-TSSA

TRF

FHWA

™P

PEPS

IfYes

IAJR, Schematic, Native
Analysis Files -
Electronic Copy

28



Documentation Rela_tionship and Sequence

Schematic (Geometric Design + Signing Layout)

NEPA Document

FHWA Conditional IAJR
Adequate detail to determine impacts Acceptance Only*

Supports capacity and operational analysis
Documents design criteria used

To be submitted to DES for review

Does not require FHWA review/approval (subject to NEPA

PODI requirements) Schematic Approval
?

Requires a schematic

Review/Approval does not require an approved IAJR

IAJR FHWA IAJR

Approval *

FHWA approval requires:
* Schematic (Geometric Design + Signing Layout)

* NEPA approval (delegated to TxDOT)

*Only one FHWA letter will be issued, either conditional
acceptance or approval




Documentation Rela_tionship and Sequence

= PS&E

— Must reflect the schematic
— Must reflect the IAJR

— Ramp location change may
trigger:

* Additional analysis up to
including IAJR re-
evaluation

* Possible NEPA
amendment

— Other design changes that
impact the schematic may
trigger NEPA re-evaluation
(just be aware)

FHWA Conditional IAJR
Acceptance Only*

NEPA

Schematic Approval
?

FHWA IAJR
Approval *
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Methodology - Early Coordination Meeting

> For the purpose of developing a technical approach for IAJR development
> Required for all projects with potential for IAJR

> District, DES, and FHWA should attend

> Initial determination of project reasonableness

> Attachment D provides a typical meeting agenda

> Meeting notes should be documented and included in the IAJR

> Additional meetings may be required for major/complex projects




Attachment D - IAJ_R Methodology

Interstate Access Justification Report
TxDOT Standard Operating Procedures (SOP)

Attachment D
Proposed IAJR Methodology and Assumptions

Coordination Meeting Agenda
(for determining safety, operation and engineering acceptability)

1. Need and Purpose
a. Project description
b. Project location map
. Alternatives
2. Area of Influence
a. Mainlane
b. Cross Roads
3. Analysis Years
a. Existing
b. Opening
c. Design
d. Interim
4. Data Collection
a. Historic traffic count
i. Source
b. Current traffic count
c. Historic arash data
i. Source
5. Traffic Forecasting
a. TP&P
b. MPO/TDM
¢ Hybrid
6. Traffic Operational Analysis
a. Existing
i. AreaType
ii. Traffic Conditions
b. Procedures/Tools
i. HOM/HCS
ii. HCM/HCS + Synchro
iii. CORSIM/VISSIM
. Measure of Effectiveness
i LOs
ii. Travel Time/Speed
ii. Calibration

33



Methodology - Eal_'ly Coordination Meeting

Common Issues in IAJR

> Poor Need
> Not considering other Alternatives Ij
> Insufficient Area of Influence Interstate Access

Justification Report (IAJR)

> Ignoring crossroads

> Unreasonable design volume

> Inappropriate traffic analysis t00Is seleClion crrErErEE
> Weak safety analysis

> Phased project implementation but no interim year analysis

»> Documentation missing or provided too much

» Skimming in re-evaluation



Methodology

» Need

> Alternatives

> Area of Influence

» Analysis Years

» Analysis Periods

> Data Collection

» Traffic Forecasting

» Traffic Operational Analysis

» Safety Analysis



Methodology - Nee

> Need for Access Modification
> ldentify transportation problems
» Proposed improvements that address the problems
» Specific to access change
> Based on existing conditions and No-build conditions in design year
> The need should be supported by existing data
> Utilize available existing data

» Traffic Volume - Statewide Traffic Analysis and Reporting System
(STARS) http://txdot.ms2soft.com/tcds/tsearch.asp?loc=Txdot&mod

» Crash data - Crash Recording Information System (CRIS)

https://cris.dot.state.tx.us/public/Query/app/public/welcome




Methodology - Alternatives

> Access Alternatives

> All reasonable build alternatives should be considered

> Reasons/justification for their inclusion or exclusion
> At a minimum, the following should be considered
> No-build Alternative
> No action
> Existing condition + committed improvements
> Transportation System Management (TSM)
> HOV, Transit

> Ramp metering, demand management



Methodology - Alternatives

>

Access Alternatives

> Improvements to Alternate Interchanges
> Existing interchange capacity improvements
> Ramp terminals/intersections
> Frontage roads
> Cross roads/local roadway network

> Alternatives Providing a Change in Access
> Interchange locations/configurations

> An alternative analysis memo will be included in the report



Methodology - Alternatives

> Alternatives

> Operational and safety analysis will be based on selected
build alt

> The selected build alt best meets the need and purpose

> The selected build alt should result in safety and
operations equal to or better than the no-build alt

> A sensitivity analysis may be required to evaluate
operational performance by varying traffic demand 5-
15%



Methodology - Are of Influence

> Area of Influence is the area impacted by the proposed change
> Factors to be considered
> Area type
> Interchange spacing
> Extent of congestion
> Anticipated traffic impacts
> Along Mainlane
> In urban area, at least one adjacent interchange in either direction
> In rural area, depends upon the interchange spacing
> Along Crossroad
>34 mile in either direction of proposed change
> Crossroad of adjacent interchange usually not included
> A figure showing Area of Influence will be included in the report



Methodology - Area _of Influence (FHWA Guide)

Project Limits

Area of Influence
Of Crossroad

Area of Influence
on Crossroad

i | (e |
N —
Area of Influence
On Interstate




Methodology - Analysis Years

> Existing, Opening and Design Years required for each project.
> Existing year analysis will only include existing conditions.
> Opening and Design years will include both no-build and build conditions.

> Existing Year
» Should be start of IAJR Analysis or
> Preferably within 1 to 3 years from IAJR approval Existing Year Opening W Interim Year |l Design Year
« Galibration Analysis Analysis Analysis
> Design Year - Baseline « Baseline - Baseline

= Alternatives « Alternatives = Altematives

> Minimum 20 years after approval of final plans

> Preferably, Opening + 20 years
> Opening Year
> First year at which project is opened to traffic
» For Phase construction, opening year of first phase
> Interim Year
> Opening year of different phases
> when design year shows failure



Methodology - Analysis Periods

> 30t highest hourly volume (design hour volume) minimum
> AM and PM peak hour may be required
> Existing 24-hr volumes should be evaluated to verify
> Peak periods versus peak hours
> Design Hour or K-factor
> Peak hour selection
> For oversaturated conditions
> Multi-hour peak period may be needed

> 24-hr volume profile shall be evaluated



Methodology —Data_ Collection

> Data Collection
> Roadway Geometry, Traffic Control
> Traffic Count, Travel Time, etc
»Crash Data
»>Summary of data collection

> Traffic Count

>

YV V YV VY

Weekday min. 48-hr

Classification count

Weekend (if required)

Where Microsimulation is used, one week or more for calibration

Actual traffic counts within 1 to 3 yrs of IAJR approval



Traffic Forecasting

> Traffic forecasting is complex and requires understanding of i
> Land use . E‘I
. TR, ,EK:»"
> Demographics | l
> Project location

> TXDOT Transportation Planning & Programming Division (TP&P) provides guidance and
approval requirements

> TP&P-Traffic Analysis Section (TPP-T) SOP
> Three approaches to develop traffic forecasts
> Pivot/Trend Line/Growth Method
> Based on historic growth
> Travel Demand Model (TDM)
» Utilizing MPO TDM
> Comparing TDM output with traffic counts, land use
> Hybrid Approach
> Combination of TDM and Growth Factor
> Start with TDM and adjust with growth factor



Traffic Forecasting Approval

TP&P provides three options for approval
> Option A: TPP-T Development

> TPP-T develops and signs & seals
> Option B: District and TPP-T Joint Development
> District/Consultant develop
> TPP reviews and signs & seals
> Option C: District Development
> District/Consultants develop

> District reviews and signs & seals

A traffic projections/forecast memo is required



Traffic Operational Analysis

Scope and Approach depend on

> Area Type
> Urban/Suburban/Rural

> Traffic conditions
» Congested/un-congested

> Complexity of Project/Analysis Tools
> Isolated /System interchange

> Selection of Analysis Tools
» Measures of Effectiveness (MOES)
> Cost Effectiveness

> FHWA Traffic Analysis Toolbox



Traffic Operational Analysis

Analysis Tools - TxDOT supports the following
> Highway Capacity Manual (HCM) based (HCS and Synchro)
> For Isolated and Under-saturated traffic
> HCS for freeway facilities
> Synchro for intersections
> Microsimulation (VISSIM/CORSIM)
> Urban freeway within business district of metro area
> Congestion extended for multi-hour
> Complex weaving or System Interchange
> Non-traditional interchange/intersection
> A calibration memo will be required
> Measures of Effectiveness (MOES)
> LOS, Travel Time, Speed, Delay, Queue Length



Traffic Operational Analysis

Analysis Tools
»>HCM based (HCS, Synchro) = FEFF | T
> Quick & Reliable T T 1~F 1" 11T
> Good for Isolated locations "
> Limitations = -
>Microsimulation (CORSIM, VISSIM) N
> Good for longer congestion f
> Good for system effect 3‘*@‘?—“‘;\:’: _» -

> Good for presentation
> Data requirement

> Time consuming




Traffic Operational Analysis

Traffic Modeling Process

DATA COLLECTION

BASE MODEL

CALIBRATION

ALTERNATIVE
ANALYSIS

DOCUMENTATION




Traffic Operational Analysis

> Analysis must be done for
> Each scenario
> All analysis periods
> Each study area segment
> Analysis should Identify
> Segments /intersections with unacceptable MOEs
> Reasons for failing
> Potential mitigating measures
> Needed improvements within the study area

» The effect of failure on Interstate Operation



Safety Analysis

Scope and Methodology
> Project type and Location
> Complexity
> Crash History
> Need and Purpose
> Safety Analysis Study Area
> Option A (Preferred)
> Historical Crash Analysis and HSM Predictive Method
> Option B

> Historical Crash Analysis and CMF Evaluation



Safety Analysis |

Historical Crash Analysis

> Latest 3 to 5 years (Determined during Coordination Meeting)
> To identify or confirm safety problems
> Analysis should include

> Crash Frequency by facility type for each year

> Crash Severity by facility type for each year

> Crash rates (to be compared with Statewide Average)

> Primary contributing factors

> Manner of collision for each year by time of day

> Crash Diagram/High Accident Location

> Heat maps/Bar Charts/GIS



Safety Analysis

Predictive Crash Analysis
SR
> Predictive or Quantitative analysis should be MANUAL v o

based on <
> Highway Safety Manual (HSM ,: L@ W
ghviay Safety Manual (HEWD & | IKSDV
> Safety Performance Equations (SPFs) i "Seter Resds Tarsugh

YV ] er Design

> Crash Modification Factors (CMFs)

> Analysis will be done for no-build and build '
conditions of design year

> Tools CRASH MODIFICATION FACTORS CLEARINGHOUSE

> For Urban Interchange - ISATe/IHSDM
> For Urban corridor - IHSDM

> For Suburban/Rural area - Highway Safety H‘ P 4 s

Software (HSS)/IHSDM




Safety Analysis |

Safety Analysis Study Area

> Area impacted by the proposed project
> Traffic analysis study area is a good starting point
> Depends upon the safety impacts of the proposed project
> Along Mainlane
> Minimum One adjacent interchange on either side of proposed change
> Along Crossroad
> 0ne-half mile from the ramp terminal

» Sample Area of Influence



Design Consideratin

Proposed Design should:
> Meet or exceed current design standards
> Not include partial interchange
> Only include access to public road
Design Exception (if required)
>Should be noted in the IAJR
> Request should be submitted separately
IAJR will include
> Design schematics i/c signing layout

> DSR showing design criteria
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IAJR Report

Interstate Access Justification Report
TxDOT Standard O, i (sor)

Attachment E
IAJR Report Outline

1. Executive Summary
2. Introduction
a. Background
b. Purpose
c. Project Location
3. Consideration and Requirements
3.1 Purpose and Need (Policy Points 1 & 2):
3.1.1 Existing Condf and Consi ion of Ir
an Access Change.

P ts That Do Not Reg

3.1 2 Transportation System Management Considerations
313 Summary of Build Alternatives
3.2 Operational and Safety Analysis (Policy Point 3)
3.2.1 Traffic Operational Analysis
a. Alternatives
b. Traffic Volume
c. Alternative Analysis
3.2 2 Safety Analysis
a. Historical Crash Analysis
b. Crash Modification Estimation
c. Predictive Crash Analysis
3.3 Connects to Public Road and Provides for All Traffic Movements (Policy Point 4)
3.4 Consistency with Local / Regional Plans (Policy Point 5)
3.5 Long Range-System or Network Plan (Policy Point 6)

3.6 Commitments and Coordination with Stakeholders (Policy Point 7)
3.7 Environmental Status (Policy Point 8)

4. Conclusion
4.1 Recommendations
4.2 Funding
4.3 Schedules
Appendix:
A Schematic / Signing Plan
B Alternatives Analysis Report
C Methodology & Assumptions
D Calibration Report
E Traffic Count Data
F Traffic Forecast
G Traffic Operation Model Output
H Crash Data / Analysis Output
I

Coordination Documentation
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IAJR Re-evaluatior_l

> Three primary conditions when IAJR Re-evaluation is required:
> Change in approved IAJR design concepts
> Significant changes in conditions
> Time Lapse before construction
> Change in approved IAJR design concepts
>Due to NEPA/environmental impacts
> Proposed design will be compared with no-build
> During final design
> Proposed design will be compared with approved IAJR/No-build
> Due to Design-Build ATC

> Proposed design will be compared with approved IAJR



IAJR Re-evaluation

> Significant changes in conditions
> Traffic
> Land Use
> Environment
> Project is justified under the new conditions
> Time Lapse before construction
> If the construction doesn’t start within 3 years after IAJR acceptance

> Update traffic & safety data and analysis as required



IAJR Re-evaluation

> Early Coordination with DES, FHWA, ENV & TP&P
> To determine the scope of re-evaluation
> Effect of re-evaluation on NEPA
> Level of analysis required
> Scope of re-evaluation
> Safety
> Operation
> Design criteria
> Approved design concept becomes benchmark

> Proposed design should operate better or at a minimum same
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IAJR Quality Control _QC)

> QC is a Critical Part of
> Technical Analysis and
> IAJR Report
> Detailed Review should be done prior to submittal

> District is responsible for QC review
> DES will perform Quality Assurance (QA)
> Tight schedule should not affect the quality of analysis and report
> Draft Tech Memo should be provided to DES for advance review

> Methodology

> Alternative Analysis Report

> Traffic Forecasting

> Model Calibration



IAJR Quality Control_(QC)

> Review Schedule
> Interim Reviews- DES: 1 to 2 weeks
> Draft IAJR - DES: 3 to 4 weeks
> FHWA TX Division: 30 days
> FHWA HQ (if applicable): 60 days
> These do not include revisions

> Additional time will be required for subsequent reviews



IAJR QC Checklist

Interstate Access Justification Report
Engineering Operations and Safety Analysis
TxDOT Standard Operating Procedures (SOP)
Attachment F
Interstate Access Justification Report (IAJR)
Quality Control Checklist

Methodology Coordination
Methodology & Assumptions Coordination Meeting (M&A) conducted and

[

meeting minutes documented

2 ME&A Memo includes a project description along with a project location map
3 Need and Purpose supported by data and justifies the project
4 Area of influence includes adjacent interchanges & intersections as per M&A
5 Analysis years per M&A
6 Project implementation Phasing
Traffic Volume
73 Existing traffic count data collected
Traffic forecasts are ped per TPP g and app by TxDOT
9 Traffic forecast methodol and i memo is included
10 If Travel demand model (TDM) used for traffic forecasting, TDM is

latest/approved model

11 Traffic forecasts are checked for reasonableness
Traffic Analysis

12 Traffic analysis tools selected per M&A
13 Latest guidelines/standards have been used

14 Study area type is Central Business District

15 Existing and/or expected future traffic conditions is saturated

16 If microsimulation tool was used, the report includes the calibration memo

Measure of Effectiveness (MOEs) are consistent with analysis tools and project
settings
18 The results of traffic lysis been d for r bl

19 The results of build year analysis show better or equal operational conditions

17

20 The traffic analysis software files checked to verify input, and parameters

Safety Analysis
21 The safeaanalvsis study area selected per M&A

22 The historical crash data and analysis conducted for latest 3 to 5 years

23 The safety analysis includes predicted crash frequency or evaluation of CMF
Report

24 Design schematic is included

25 Signing plan is included

The proposed project is consistent with State/MPO/local plan and
documentation included

26




Questions?
Feedback

Contact

Khalid Jamil, P.E. Sharlotte Teague, P.E.
(512)486-5171 (512)416-2673
Khalid.jamil@txdot.gov sharlotte.teague@txdot.gov



